
Label

Use this shape to label the paths in your drawing. Position on path shapes. To replace existing text, select
the shape, then type. To resize the symbol, right-click the shape, choose the appropriate command, then 
drag the control handle .



Direction Of Flow

Use with the transmission path shape. To specify the arrowhead location, right-click the shape. To see 
what a control handle  on a selected shape does, pause the pointer over the handle. To add text, select 
the shape, then type.



Test Point

Represents a point on a circuit that can be easily tested or probed. To connect other shapes, glue an 
endpoint on this shape to a connection point  on the other shapes. To add text, select the shape, then 
type.



Terminal 3-Phase

To add the terminal number, select the shape, subselect a terminal, then type. To move the text, right-click
the shape, choose Open Terminal 3-Phase, then drag the control handle in the group window. Close the 
group window to return to the drawing window.



Junction

Represents a line connection. Position at the intersection of two lines. To resize the symbol, right-click the
shape, choose the appropriate command, then drag the control handle .



Bus Width

Represents the number of lines on the bus. Position on a bus shape. To replace existing text, select the 
shape, then type. To resize proportionally, drag a corner selection handle.



Multi-line Bus Connector

To connect other shapes, glue an endpoint on this shape to a connection point  on the other shapes. To 
add text, select the shape, then type.



Lead Group

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To move a lead, drag a control handle 

. To delete a lead, drag a control handle to the shape's center. To add text, select the shape, then type. 
To resize proportionally, drag a corner selection handle.



Overground Enclosure

To add text, select the shape, then type. To move the text, drag the control handle . To resize 
proportionally, drag a corner selection handle.



Line Equipment

Use this shape with line or cable shapes to represent equipment. To resize proportionally, drag a corner 
selection handle.



3-Line Bus Connector

Use this shape with the rotating machine shape on the rotating equipment stencil. To specify an even or 
extended line type, right-click the shape. To add text, select the shape, then type.



Bus Shape

To open or close the arrow's tail, right-click the shape. To connect other shapes, glue this shape's 
endpoints to connection points  on the other shapes. To add text, select the shape, then type. To change
the width of straight bus shapes, drag a side selection handle. To change the width of elbow bus shapes, 
drag the control handle 

.



Terminal

To add the terminal number, select the shape, then type. To move the text, drag the control handle . To 
resize proportionally, drag a corner selection handle.



Optical Fiber

To add text, select the shape, then type. To move the text, drag the control handle .
Note: The Optical Qualifier always remains upright.



Cable Group

Represents a five-conductor application cable. To connect this shape to other shapes, glue an endpoint 
on a 1-D shape to a connection point  on this shape. To add text, select the shape, then type. To resize 
proportionally, drag a corner selection handle.



Transmission Path

Use with the direction of flow shape. To add text, select the shape, then type.



3-State Data

Connect this shape, which represents three-state data valid periods, to straight lines, which represent 
invalid data periods.



Signal Waveform

To specify a waveform type, right-click the shape. To indicate intermittent flat waveforms, connect this 
shape with straight lines. To resize proportionally, drag a selection handle.



Clock

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To replace the existing clock speed, select the shape, then type the speed you want. To resize the 
clock, drag a selection handle.



Flip-flop Configurable Logic

To choose flip-flop type, right-click the shape. To add text, select the shape, then type. To move the text, 
drag the control handle . To connect a flip-flop shape to other shapes, glue the endpoints from the other 
shapes to connection points 

 on the flip-flop shape.



Generator

When you drop the shape on the page, Visio prompts you to choose a shape type and the number of 
inputs and outputs. To change shape properties at any other time, right-click the shape. To add text, 
select the shape, then type. To move the text, drag the control handle . To connect this shape to other 
shapes, glue the endpoints from other shapes to the connection handles 

 on the logic shape.



Basic Logic Shape

To specify a logic shape type, right-click the shape. To resize the shape, drag a selection handle. To add 
text, select the shape, then type. To see what a control handle  on a selected shape does, pause the 
pointer over the handle. To connect this shape to other shapes, glue an endpoint on a 1-D shape to a 
connection point 

 on this shape.



Dimension Line

Position and resize to match the area you're measuring. The text field automatically adjusts to show the 
length of the line. To show or hide extension lines, right-click the shape. To resize a shape and dimension 
line simultaneously, glue the endpoints on the dimension line to selection handles on the shape. (Note: If 
the endpoints don't glue to a shape's selection handles, choose Tools > Snap & Glue, then check Shape 
Handles under Glue To).

A      Drag to meet the edge of the area you want to measure.



Negative Logic Dot

To indicate negative logic in a logic shape, select a logic gates shape, then choose Open Logic Gates 
from the Edit menu. Drag the negative logic dot into the appropriate position in the group window, then 
click the close box.



Basic Logic Shape

To resize the shape, drag a selection handle. To add text, select the shape, then type. To see what a 
control handle  on a selected shape does, pause the pointer over the handle. To connect this shape to 
other shapes, glue an endpoint on a 1-D shape to a connection point 

 on this shape.



Configurable Logic

When you drop the shape on the page, Visio prompts you to choose shape type and the number of inputs
and outputs. To change shape properties at any other time, right-click the shape. To add text, select the 
shape, then type. To move the text, drag the control handle . To connect this shape to other shapes, 
glue an endpoint on a 1-D shape to a connection point 

 on this shape.



Amplifier

When you drop this shape on the page, Visio prompts you to choose an amplifier type and the number of 
inputs and outputs. To change amplifier properties at any other time, right-click the shape. To replace the 
text for an output/input value, subselect existing text, then type. To add additional text, select the shape, 
then type. To move the additional text, drag the control handle . To connect an amplifier to other shapes,
glue the endpoints from other shapes to the connection handles 

 on the amplifier.



Premade Integrated Circuit Components

To replace existing text outside the shape, select the shape, then type. To customize the circuit, subselect
text inside the shape, then type. To connect this shape to other shapes, glue an endpoint on a 1-D shape 
to a connection point  on this shape.



Extension

To specify an extension type or change extension orientation, right-click the shape. To replace existing 
text, subselect the text, then type. To connect an extension to another shape, glue its endpoints to 
connection points  on other shapes.



Integrated Circuit Component

To choose circuit type or reverse a circuit, right-click a circuit shape. To change the number of connectors,
right-click a circuit, then choose Configure Chip. To name a circuit, select it, then type. To move the name,
drag the control handle . To replace text related to connections, inputs, or outputs, subselect the text, 
then type. To connect circuits to other shapes, glue the endpoints on a connector shape to connection 
points 

 on the circuit.



Switch Point and Ground

To specify a switch-point or ground type, right-click the shape. To add text, select the shape, then type. To
see what a control handle  on a selected shape does, pause the pointer over the handle. To connect 
other shapes, glue an endpoint on this shape to a connection point 

 on the other shapes.



Board

Position this shape around an integrated circuit to represent a board. To resize the shape, drag a side or 
corner selection handle. To add text to the top section of the shape, select the shape, then type. To resize 
the shape sections, drag the control handle .



Converter

To specify the converter type, right-click the shape.
To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape.



Heat Source

To specify the heat source type, right-click the shape. To connect this shape to other shapes, glue an 
endpoint on a 1-D shape to a connection point  on this shape.



Composite Symbol

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. Details about a particular composite shape appears in the status bar when you place the pointer 
over the shapes on the stencil.
A symbol's aspect ratio is locked. To resize proportionally, drag any handle.



Amplifier, Repeater, Phase Shifter

To specify the number of lines or wires, right-click the shape. For phase shifters, choose 3-wire or 
General. For amplifiers and repeaters, choose One Line or Two Lines.
To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape.



Proximity Sensor

To specify the sensor type, right-click the shape. To connect this shape to other shapes, glue an endpoint 
on a 1-D shape to a connection point  on this shape.



Generic Component

To change the component type, right-click the shape. To add text, or replace existing text, select a shape, 
then type. To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point

 on this shape.



Basic Electrical Shape

To add text, select a shape, then type. To move the text, drag the control handle . To connect this shape 
to other shapes, glue an endpoint on a 1-D shape to a connection point 

 on this shape.



Assorted Fundamental Shapes

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type. To move the text, drag the control handle 

.



Assorted Fundamental Shapes

To specify a different type, right-click the shape. To connect this shape to other shapes, glue an endpoint 
on a 1-D shape to a connection point  on this shape. To add text, select the shape, then type. To move 
the text, drag the control handle 

.



Assorted Fundamental Shapes

When you drop the shape on the page, Visio prompts you for the shape type. To connect this shape to 
other shapes, glue an endpoint on a 1-D shape to a connection point  on this shape. To add text, select 
the shape, then type. To move the text, drag the control handle 

.



Winding Connection

When you drop the shape on the page, Visio prompts you to choose a winding type. To set the winding 
configuration at any other time, right-click the shape. To add text, select the shape, then type. To move 
the text, drag the control handle . The shape's aspect ratio is locked. To resize proportionally, drag any 
selection handle.



Configurable Electrical Shape

To specify an electrical shape type, right-click the shape. To add text, or replace existing text, select the 
shape, then type. To move the text, drag the control handle . To connect this shape to other shapes, 
glue an endpoint on a 1-D shape to a connection point 

 on this shape.



Synchro

When you drop the shape on the page, Visio prompts you to choose a synchro type. To set the synchro 
type at any other time, right-click the shape. To add text, select the shape, then type. To move the text, 
drag the control handle . The shape's aspect ratio is locked. To resize proportionally, drag any selection 
handle.



Basic Sliding Electrical Shape

To change the horizontal position of the shape body, drag the control handle . To add text, select a 
shape, then type. To connect other shapes, glue an endpoint on this shape to a connection point 

 on the other shapes.

A      Glue to connection points  on other shapes. Drag to lengthen the line.
B      Drag to resize the shape.
C      Drag to change the horizontal position of the shape body on the line.



Configurable Sliding Electrical Shape

To specify an electrical shape type, right-click the shape. To change the horizontal position of the shape 
body, drag the control handle . To add text, select a shape, then type. To move the text, drag the control 
handle. To connect other shapes, glue an endpoint on this shape to a connection point 

 on the other shapes.

A      Glue to connection points  on other shapes. Drag to lengthen the line.
B      Drag to resize the shape.
C      Drag to change the horizontal position of the shape body on the line.



Configurable Electrical Shape

To specify an electrical shape type, right-click the shape. To add text, select a shape, then type. To move 
the text, drag the control handle . To connect this shape to other shapes, glue an endpoint on a 1-D 
shape to a connection point 

 on this shape.



Ferrite Core

To specify a reflector type, right-click the shape. To connect this shape to other shapes, glue an endpoint 
on a 1-D shape to a connection point  on this shape. To add text, select the shape, then type. To move 
the text, drag the control handle 

.



Basic Electrical Shape

To add text, select a shape, then type. To move the text, drag the control handle . To connect this shape 
to other shapes, glue an endpoint on a 1-D shape to a connection point 

 on this shape.



Field

When you drop the shape on the page, Visio prompts you to choose a field type. To set the field type at 
any other time, right-click the shape. The shape's aspect ratio is locked. To resize proportionally, drag any
selection handle.



Latching Device

To specify an engaged or disengaged latch, right-click the shape. To add text, select the shape, then type.
To move the text, drag the control handle .



Rotating Machine

When you drop the shape on the page, Visio prompts you to choose the machine type and qualifier. To 
set the machine configuration at any other time, right-click the shape. To add text, select the shape, then 
type. To move the text, drag the control handle . To resize proportionally, drag a selection handle.



Armature

To add an armature to the rotating machine, position this shape on top of the rotating machine shape. The
shape's aspect ratio is locked. To resize proportionally, drag any selection handle.



Brush

Represents a brush on a rotating machine. To connect to other shapes, glue an endpoint on this shape to 
a connection point  on the rotating machine.



Mechanical Equipment

Represents various types of mechanical equipment used in industrial control systems. To add text, select 
the shape, then type.



Manual Control

To specify how the manual control is operated, right-click the shape. To set restricted or normal access, 
right-click the shape. To add text, select the shape, then type. To move the text, drag the control handle .



Mechanical Interlock

To resize proportionally, drag a corner selection handle. To add text, select the shape, then type. To move 
the text, drag the control handle .



Clutch

Represents a clutch. To specify an engaged or disengaged clutch, right-click the shape. To add text, 
select the shape, then type. The shape's aspect ratio is locked. To resize proportionally, drag any 
selection handle.



Blocking Device

To specify the blocking type, right-click the shape. To add text, select the shape, then type. To move the 
text, drag the control handle .



Delayed Action

To change the form of the delayed action shape, right-click the shape. To add text, select the shape, then 
type. To move the text, drag the control handle .



Detent

To set the state of the detent, right-click the shape. To add text, select the shape, then type. To move the 
text, drag the control handle .



Automatic Return

The arrow in the center of the shape points toward the return direction. To indicate return to the right, 
select the shape, then choose Shape > Flip Horizontal (or press Ctrl+H). To add text, select the shape, 
then type. To move the text, drag the control handle .



Rotation

To indicate rotation in one direction or both directions, right-click the shape. To indicate clockwise rotation,
select the shape, then choose Flip Horizontal from the Shape menu (or press Ctrl+H). To add text, select 
the shape, then type. To move the text, drag the control handle .



Telephone

To specify the telephone type, right-click the shape.
The shape's aspect ratio is locked. To resize proportionally, drag any handle.



Station

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. The shape's aspect ratio is locked. To resize proportionally, drag any handle. To add text, select 
the shape, then type. To move the text, drag the control handle 

.



Power Station

To indicate whether the station is in service or planned, right-click the shape.
To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape.



Telegraph

To specify the telegraph type, right-click the shape. For a repeater, choose One-way Simplex, Two-way 
Simplex, or Duplex. For equipment, choose General, Transmitter, Receiver, Two-way Simplex, or Duplex.
To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape.



Qualifier

Position a qualifier shape on or near a telegraph or station shape. To specify the qualifier type, right-click 
the shape.
For telegraph equipment, choose from Tape Printing, Page Printing, Keyboard, or Facsimile.
For a telegraph repeater, choose from Polar Direct-current, Neutral Direct-current (+/o), or Neutral Direct-
current (-/o).
For a prime mover, choose from Gas Turbine or Reciprocating Engine.



Space Station

To specify the station type, right-click the shape.
To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type. To move the text, drag the control handle 

.



Connection Symbols

To resize a symbol proportionally, drag any selection handle. To connect this shape to other shapes, glue 
an endpoint on a 1-D shape to a connection point  on this shape.



Connection and Qualifying Symbols

Some symbols have more than one form. To specify the form of the symbol, right-click the shape. To 
resize the symbol proportionally, drag any selection handle.



Semiconductors

To change a semiconductor form, right-click the shape. To connect this shape to other shapes, glue an 
endpoint on a 1-D shape to a connection point  on this shape. To add text, select the shape, then type. 
To move the text, drag a control handle 

.



Semiconductors

To change a semiconductor form, right-click the shape. To connect other shapes, glue an endpoint on this
shape to a connection point  on the other shapes. To add text, select the shape, then type. To move the 
text, drag a control handle 

.



Connection

To add this shape to the envelope of a transistor shape, glue the endpoint of the shape to a connection 
point  on a transistor shape. The transistor shape should have its right-click action to Show Envelope 
selected. To resize the shape proportionally, drag a selection handle.



Switches and Relays

To connect other shapes, glue an endpoint on this shape to a connection point  on the other shapes. To 
add text, select the shape, then type. Control handles provide other shape actions. To see what a control 
handle 

 on a selected shape does, pause the pointer over the handle.



Contacts

To configure or change a contact form, right-click the shape. To connect other shapes, glue an endpoint 
on this shape to a connection point  on the other shapes.



Switches and Relays

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To specify a different type, right-click the shape. Control handles provide other shape actions. To 
see what a control handle 

 on a selected shape does, pause the pointer over the handle.



Switches

To specify a switch form, right-click the shape. To add text, select the shape, then type. To move the text, 
drag the control handle . To connect other shapes, glue an endpoint on this shape to a connection point 

 on the other shapes.



Switches

To change switch position or form, right-click the shape. To add text, select the shape, then type. To move
the text, drag the control handle . To connect this shape to other shapes, glue an endpoint on a 1-D 
shape to a connection point 

 on this shape.



Amplified Circuit

To specify both-way or unidirectional amplification, right-click the shape. To add text, select the shape, 
then type. To move the text, drag the control handle . To resize proportionally, drag a selection handle.



Frequency Spectrum Diagram Symbols

To specify the type of frequency, right-click the shape. To add text, select the shape, then type. To move 
the text, drag the control handle . The shape's aspect ratio is locked. To resize proportionally, drag any 
selection handle.



Switching Function Qualifying Symbol

To specify a concentrating or expanding switching function, right-click the shape. The shape's aspect ratio
is locked. To resize proportionally, drag any selection handle.



Modulator

To add text, select the shape, then type. To move the text, drag the control handle . The shape's aspect 
ratio is locked. To resize proportionally, drag any selection handle.



Networks

To specify the type of device, right-click the shape. To add text, select the shape, then type. To move the 
text, drag the control handle . The shape's aspect ratio is locked. To resize proportionally, drag any 
selection handle.



Frequency Band

To specify the type of frequency band, right-click the shape. To add text, select the shape, then type. To 
move the text, drag the control handle . To change the number of channels when using the Group Of 
Erect Channels shape, subselect the shape, then type. The shape's aspect ratio is locked. To resize 
proportionally, drag any selection handle.



Pulse Modulation Qualifier

To specify the type of modulation, right-click the shape. To add text, select the shape, then type. To move 
the text, drag the control handle . The shape's aspect ratio is locked. To resize proportionally, drag any 
selection handle.



Terminating Sets

To specify the type of terminating set, right-click the shape. To add text, select the shape, then type. To 
move the text, drag the control handle . The shape's aspect ratio is locked. To resize proportionally, drag
any selection handle.



Transducer Head

To specify the use of a transducer head, right-click the shape, then choose either Recording or 
Reproducing. To change a transducer head type, right-click the shape. To add text, select the shape, then
type. To move the text, drag the control handle .



Recorder/Reproducer

To specify a general, recorder/reproducer, or reproducer device, right-click the shape. To specify the type, 
add qualifying symbols. To add text, select the shape, then type. To move the text, drag the control handle

.



Qualifying Symbol

Position a qualifying symbol on a recording/reproducing shape to specify the type. The shape's aspect 
ratio is locked. To resize proportionally, drag any selection handle.



Switching Equipment

Indicates automatic or manual switching in trunking diagrams. To add text, select the shape, then type. To
move the text, drag the control handle . The shape's aspect ratio is locked. To resize proportionally, drag
any selection handle.



Switching System Qualifying Symbol

To indicate a stage type, glue the endpoint of the shape to the connection point  on the inlet or outlet of 
the connecting stage shape. To resize the shape proportionally, drag a selection handle.



Connecting Stage

To specify the number of inlets, outlets, and grading groups, right-click the shape, then choose Properties.
The numbers display above the inlet, outlet 1, and below the shape, respectively. To position inlets and 
outlets, drag the control handles . Note that text indicating the number of outlets moves with outlet 1, so 
outlet 1 should be in the topmost position.
To add a label, select the shape, then type. To move the text, drag the text block control handle.



Changer

To specify the type of symbol, right-click the shape. To specify a multiplier or frequencies on a frequency 
changer shape, subselect the text, then type. To add a label, select the shape, then type. To move the 
text, drag the control handle . The shape's aspect ratio is locked. To resize proportionally, drag any 
selection handle.



Filter

To specify the type of filter, right-click the shape. To add text, select the shape, then type. To move the 
text, drag the control handle . The shape's aspect ratio is locked. To resize proportionally, drag any 
selection handle.



Fiber Optic Devices

To specify a transmitter or receiver, right-click the shape. To add text, select the shape, then type. To 
move the text, drag the control handle . The shape's aspect ratio is locked. To resize proportionally, drag
any selection handle.



Normalled Jack

Represents a two-conductor jack with the circuit normalled through one way. To connect this shape to 
other shapes, glue an endpoint on a 1-D shape to a connection point  on this shape. To add text, select 
the shape, then type.



2-conductor Jack and Plug

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type.



Normalled Jacks

Represents a circuit normalled through both ways. To connect this shape to other shapes, glue an 
endpoint on a 1-D shape to a connection point  on this shape. To add text, select the shape, then type.



AC Out

To create a female connector, subselect the prong shapes and choose Format > Style > Fill Style > Black 
Fill. To connect this shape to other shapes, glue an endpoint on a 1-D shape to this shape's connection 
points .



Connector

Represents a D-type connector with few or many pins, or a 15-pin Type-C connector. 
For the Type-C connector, to create a 26-, 34-, 50-pin, or other C-header connector, drag a selection 
handle to resize the shape proportionally.



Cable Termination

To specify a complete or single-line symbol, right-click the shape. To add text, select the shape, then type.
To move the text, drag the control handle . To connect this shape to other shapes, glue an endpoint on a
1-D shape to a connection point 

 on this shape.



Terminal Board

To add a terminal number, subselect a terminal in the terminal board, then type. To move the terminal 
numbers, right-click the terminal board, then choose Open Terminal Board. In the group window, select a 
terminal, then drag the control handle  to move the number. To close the group window, click the close 
box.



Male/Female Connector

To specify a female or male type, right-click the shape. To connect other shapes, glue an endpoint on this 
shape to a connection point  on the other shapes.



F/M 3-conductor

Represents a three-conductor, polarized, female connector. To specify a female or male contact, right-
click the shape. To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection 
point  on this shape. To add text, select the shape, then type. To resize proportionally, drag a corner 
selection handle.



Outside Conductor Coaxial

Represents a coaxial cable with the outside conductor carried through. To connect this shape to other 
shapes, glue an endpoint on a 1-D shape to a connection point  on this shape. To add text, select the 
shape, then type. To resize proportionally, drag a corner selection handle.



Center Conductor Coaxial

Represents a coaxial cable where the outside conductor is terminated on the chassis. To connect this 
shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this shape. To add 
text, select the shape, then type. To resize proportionally, drag a corner selection handle.



Jack/Plug

To specify a jack or plug, right-click the shape. To connect this shape to other shapes, glue an endpoint 
on a 1-D shape to the connection point  on this shape. To add text, select the shape, then type. To 
resize proportionally, drag a corner selection handle.



F/M 2-conductor

Represents a two-conductor, nonpolarized connector with female contacts. To specify a female or male 
contact, right-click the shape. To connect this shape to other shapes, glue an endpoint on a 1-D shape to 
a connection point  on this shape. To add text, select the shape, then type.



Circuit Terminal

To add a terminal number, select the shape, then type. To move the text, drag the control handle . To 
connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point 

 on this shape.



2-conductor Jack and Plug 2

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type. To resize proportionally, drag a corner selection handle.



Inductor

When you drop the shape on the page, Visio prompts you for the core type, adjustability type, and 
number of taps. To specify inductor properties at any other time, right-click the shape.
To move the inductor legs, drag a control handle . To add text, select the shape, then type. To move the 
text, drag the control handle. To resize proportionally, drag a corner selection handle.



Linear Coupler

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type. To move the text, drag the control handle 

. To resize proportionally, drag a corner selection handle.



Potential Transformer

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To resize proportionally, drag a corner selection handle. To add text, select the shape, then type. 
To move the text, drag the control handle 

.



Current Transformer

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type. To move the text, drag the control handle 

.



Adjustable Transformer

To specify a mutual inductor or one wingding type, right-click the shape. To add text, select the shape, 
then type. To move the text, drag the control handle . To resize proportionally, drag a corner selection 
handle.



Saturating Transformer

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type. To move the text, drag the control handle 

. To resize proportionally, drag a corner selection handle.



Transformer 2

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type. To move the text, drag the control handle 

. To resize proportionally, drag a corner selection handle.



Transformer

When you drop the shape on the page, Visio prompts you for the core type and adjustability. To specify 
transformer properties at any other time, right-click the shape. To add text, select the shape, then type. To
move the text, drag the control handle . To resize proportionally, drag a corner selection handle.



Choke

To add text, select the shape, then type. To move the text, drag the control handle . To resize 
proportionally, drag a corner selection handle.



Variometer

To add text, select the shape, then type. To move the text, drag the control handle . To resize 
proportionally, drag a corner selection handle.



Induction Voltage Regulators

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To resize proportionally, drag a corner selection handle. To add text, select the shape, then type. 
To move the text, drag the control handle 

.



Outdoor Metering Device

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type. To move the text, drag the control handle 

. To resize proportionally, drag a corner selection handle.



Transductor

Represents an assembled transductor element. To connect this shape to other shapes, glue an endpoint 
on a 1-D shape to a connection point  on this shape. To add text, select the shape, then type. To move 
the text, drag the control handle 

. To resize proportionally, drag a corner selection handle.



Magnetic Core

To specify a single- or double-line type, right-click the shape. To resize, drag a side or top selection 
handle.



Line Stretcher

To specify male or female connectors, right-click the shape. To connect this shape to other shapes, glue 
an endpoint on a 1-D shape to a connection point  on this shape. To add text, select the shape, then 
type. To resize proportionally, drag a corner selection handle.



Circulator Fixed

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type. To resize proportionally, drag a corner selection handle.



Field Polarization Amplitude Modulator

Represents a field polarization amplitude modulator. To connect this shape to other shapes, glue an 
endpoint on a 1-D shape to a connection point  on this shape. To add text, select the shape, then type. 
To resize proportionally, drag a corner selection handle.



Resonator

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type. To resize proportionally, drag a corner selection handle.



Balun

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type. To resize proportionally, drag a corner selection handle.



Mode Filter

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type.



Frequency Filter

Represents a bandpass frequency filter. To connect this shape to other shapes, glue an endpoint on a 1-D
shape to a connection point  on this shape. To add text, select the shape, then type.



Ferrite Bead Ring

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type.



Laser/Maser

To specify a maser or laser type, right-click the shape. To connect this shape to other shapes, glue an 
endpoint on a 1-D shape to a connection point  on this shape. To resize proportionally, drag a corner 
selection handle.



Ruby Laser Generator

To specify a different laser type, right-click the shape. To add text, select the shape, then type. To move 
the text, drag the control handle . To connect this shape to other shapes, glue an endpoint on a 1-D 
shape to a connection point 

 on this shape. To resize proportionally, drag a corner selection handle.



Gyrator

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type.



Circulator Reversible

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type. To resize proportionally, drag a corner selection handle.



Phase Shifter (Matched)

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type.



Inductive Susceptance

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type.



Discontinuity

Represents a two-port discontinuity. To connect this shape to other shapes, glue an endpoint on a 1-D 
shape to a connection point  on this shape. To add text, select the shape, then type.



Equivalent Series

Represents a general equivalent element in a series with a guided transmission path. To connect this 
shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this shape. To add 
text, select the shape, then type.



Capacitive Reactance

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type.



Inductive Reactance

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type.



Resistance

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type.



Inductance Capacitance 1

Represents an inductance-capacitance circuit with zero reactance at resonance. To connect this shape to 
other shapes, glue an endpoint on a 1-D shape to a connection point  on this shape. To add text, select 
the shape, then type.



Inductance Capacitance 2

Represents an inductance-capacitance circuit with infinite reactance at resonance. To connect this shape 
to other shapes, glue an endpoint on a 1-D shape to a connection point  on this shape. To add text, 
select the shape, then type.



Equivalent Shunt

Represents a general equivalent shunt element in parallel with guided transmission path. To connect 
other shapes, glue an endpoint on this shape to a connection point  on the other shapes. To add text, 
select the shape, then type.



Field Polarization Rotator

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To resize proportionally, drag a corner selection handle.



Capacitive Susceptance

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type.



Conductance

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type.



Inductance Capacitance 3

Represents an inductance-capacitance circuit that has zero reactance and infinite susceptance at 
resonance. To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point

 on this shape. To add text, select the shape, then type.



Inductance Capacitance 4

Represents an inductance-capacitance circuit that has infinite reactance and zero susceptance at 
resonance. To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point

 on this shape. To add text, select the shape, then type.



E-H Tuner

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type.



Multistub Tuner

Represents a multistub tuner with three stubs. To connect this shape to other shapes, glue an endpoint on
a 1-D shape to a connection point  on this shape. To add text, select the shape, then type.



Directional Coupler

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type.



Mode Suppressor

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type.



Rotary Joint

Represents a general rotary joint with a rectangular waveguide system. To connect this shape to other 
shapes, glue an endpoint on a 1-D shape to a connection point  on this shape. To add text, select the 
shape, then type.



Isolator

Represents a nonreciprocal device or isolator. To connect this shape to other shapes, glue an endpoint on
a 1-D shape to a connection point  on this shape. To add text, select the shape, then type.



Phase Shifter

Represents a nonreciprocal directional phase shifter. To connect this shape to other shapes, glue an 
endpoint on a 1-D shape to a connection point  on this shape. To add text, select the shape, then type.



Slide Screw Tuner

To connect this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this 
shape. To add text, select the shape, then type.



Signal Code

Represents maintenance and operating information. To specify a normal or secondary flow type, right-
click the shape. To add text, select the shape, then type. To connect this shape to other shapes, glue an 
endpoint on a 1-D shape to a connection point  on this shape.



Maintenance

Represents maintenance and operating information. To add text, select the shape, then type. To connect 
this shape to other shapes, glue an endpoint on a 1-D shape to a connection point  on this shape.






